Frequently used shortcuts

Ribbon: Access keys for tabs

Ctrl + W
Ctrl+ O
Alt+H
Ctrl+ S
Ctrl + C
Ctrl +V
Ctrl + Z
Del

Alt + H then H
Ctrl + X
Alt+N
Ctrl +B

Alt + H then A
then C

Alt+P
Alt+ A
Alt+W

Shift + F10 or
Context menu key

Alt + H then B

Alt + H then D
then C

Alt + M
Ctrl +9
Ctrl +0
Ctrl + Shift + F3

Alt + D then F
then A

Ribbon: Work in the ribbon with the

keyboard

Alt+Q

Alt+F

Close a workbook
Open a workbook
Go to the Home tab
Save a workbook
Copy

Paste

Undo

Remove cell contents
Choose a fill color
Cut

Go to Insert tab
Bold

Center align cell contents

Go to Page Layout tab
Go to Data tab
Go to View tab

Open context menu

Add borders

Delete column

Go to Formula tab

Hide the selected rows

Hide the selected columns
Create names from selection

Advanced filter

then enter the search term:
Open the Tell me box on the
Ribbon and type a search term
for assistance or Help content

Open the File page and use
Backstage view
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Alt+H

Alt+N

Alt+P

Alt+M

Alt + A

Alt+R

Alt +W
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Open the Home tab and format
text and numbers and use the
Find tool

Open the Insert tab and insert
PivotTables, charts, add-ins,
Sparklines, pictures, shapes,
headers, or text boxes

Open the Page Layout tab and
work with themes, page setup,
scale, and alignment

Open the Formulas tab and
insert, trace, and customize
functions and calculations

Open the Data tab and connect
to, sort, filter, analyze, and work
with data

Open the Review tab and check
spelling, add comments, and
protect sheets and workbooks

Open the View tab and preview
page breaks and layouts, show
and hide gridlines and headings,
set zoom magnification, manage
windows and panes, and view
macros

Navigating in cells

Alt

F10

Tab or Shift + Tab

Arrow keys

Space or Enter

Down arrow

Alt + Down arrow

(to move to a different tab, use
access keys or the arrow keys)
Select the active tab of the
ribbon, and activate the access
keys.

To move to a different tab, use
access keys or the arrow keys.
Select the active tab of the
ribbon, and activate the access
keys.

Move the focus to commands on
the ribbon

Move among the items on the
Ribbon

Activate a selected button

Open the list for a selected
command

Open the menu for a selected
button



Down arrow

Ctrl + F1

Shift + F10 or
Context menu key

Left arrow

When a menu or submenu is
open, move to the next
command

Expand or collapse the ribbon

Open a context menu

Move to the submenu when a
main menu is open or selected

Formatting cells

Shift + Tab

Up arrow

Down arrow

Left arrow

Right arrow

Ctrl + Arrow keys

End then Arrow
keys

Ctrl + End

Ctrl + Shift + End

Home + Scroll
Lock

Ctrl + Home

Page Down

Ctrl + Page Down

Alt + Page Down

Move to the previous cell in a
worksheet or the previous option
in a dialog box

Move one cell up in a worksheet

Move one cell down in a
worksheet

Move one cell left in a worksheet

Move one cell right in a
worksheet

Move to the edge of the current
data region in a worksheet

Enter End mode, move to the
next nonblank cell in the same
column or row as the active cell,
and turn off End mode. If the
cells are blank, move to the last
cell in the row or column

Move to the last cell on a
worksheet, to the lowest used
row of the rightmost used
column

Extend the selection of cells to
the last used cell on the
worksheet (lower-right corner)

Move to the cell in the upper-left
corner of the window when Scroll
Lock is turned on

Move to the beginning of a
worksheet

Move one screen down in a
worksheet

Move to the next sheet in a
workbook

Move one screen to the right in a
worksheet

Page Up

Alt + Page Up

Ctrl + Page Up

Tab

Ctrl + Alt + 5

Esc
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Move one screen up in a
worksheet

Move one screen to the left in a
worksheet

Move to the previous sheet in a
workbook

Move one cell to the right in a
worksheet. Or, in a protected
worksheet, move between
unlocked cells

and then the Tab key repeatedly:
Cycle through floating shapes,
such as text boxes or images

Exit the floating shape navigation
and return to the normal
navigation

Making selections and performing

actions
Ctrl + 1
Ctrl + Shift + F or

Ctrl + Shift + P
F2

Shift + F2
Ctrl + Shift + +

Ctrl + -

Ctrl + Shift + :
Ctrl +;
Ctrl +°

Ctrl +'

Open the Format Cells dialog
box

Format fonts in the Format Cells
dialog box

Edit the active cell and put the
insertion point at the end of its
contents. Or, if editing is turned
off for the cell, move the
insertion point into the formula
bar. If editing a formula, toggle
Point mode off or on so you can
use arrow keys to create a
reference

Add or edit a cell comment

Open the Insert dialog to insert
blank cells

Open the Delete dialog box to
delete selected cells

Enter the current time
Enter the current date

Switch between displaying cell
values or formulas in the
worksheet

Copy a formula from the cell
above the active cell into the cell
or the Formula Bar



Ctrl + X
Ctrl+ C
Ctrl + V

Ctrl + Alt +V

Ctrl + 1 or Ctrl + 3

Ctrl + Bor Ctrl + 2

Ctrl + U or Ctrl + 4

Ctrl + 5

Ctrl + 6

Ctrl + Shift + &

Ctrl + Shift + _

Ctrl + 8

Ctrl + D

Ctrl + Shift + ~

Ctrl + Shift + $

Ctrl + Shift + %

Ctrl + Shift + A

Ctrl + Shift + #

Ctrl + Shift + @

Ctrl + Shift + !

Move the selected cells
Copy the selected cells

Paste content at the insertion
point, replacing any selection

Open the Paste Special dialog
box

Italicize text or remove italic
formatting

Bold text or remove bold
formatting

Underline text or remove
underline

Apply or remove strikethrough
formatting

Switch between hiding objects,
displaying objects, and
displaying placeholders for
objects

Apply an outline border to the
selected cells

Remove the outline border from
the selected cells

Display or hide the outline
symbols

Use the Fill Down command to
copy the contents and format of
the topmost cell of a selected
range into the cells below

Apply the General number
format

Apply the Currency format with
two decimal places (negative
numbers in parentheses)

Apply the Percentage format
with no decimal places

Apply the Scientific number
format with two decimal places

Apply the Date format with the
day, month, and year

Apply the Time format with the
hour and minute, and AM or PM

Apply the Number format with
two decimal places, thousands
separator, and minus sign (-) for
negative values

Ctrl + K
F7

Ctrl + Q

Ctrl+LorCtrl+T
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Open the Insert hyperlink dialog

Check spelling in the active
worksheet or selected range

Display the Quick Analysis
options for selected cells that
contain data

Display the Create Table dialog
box

Working with data, functions, and
the formula bar

Ctrl + A or Citrl +
Shift + Space

Ctrl + Shift + Page
Down

Ctrl + Shift + Page
Up
Shift + Arrow keys

Ctrl + Shift +
Arrow keys

F8

Shift + F8

Alt + Enter

Ctrl + Enter

Shift + Enter

Ctrl + Space

Shift + Space

Ctrl + Shift +

Space

Ctrl + Shift +
Home

Ctrl + A or Ctrl +

Select the entire worksheet

Select the current and next sheet
in a workbook

Select the current and previous
sheet in a workbook

Extend the selection of cells by
one cell

Extend the selection of cells to
the last nonblank cell in the
same column or row as the
active cell, or if the next cell is
blank, to the next nonblank cell

Turn extend mode on and use
the arrow keys to extend a
selection. Press again to turn off

Add a non-adjacent cell or range
to a selection of cells by using
the arrow keys

Start a new line in the same cell

Fill the selected cell range with
the current entry

Complete a cell entry and select
the cell above

Select an entire column in a
worksheet

Select an entire row in a
worksheet

Select all objects on a worksheet
when an object is selected

Extend the selection of cells to
the beginning of the worksheet

Select the current region if the



Shift + Space

Ctrl + Shift + *

Home

Ctrl+Y

Ctrl + Z

Function keys

Ctrl + Shift + *

F2

Ctrl + Shift + U
Esc

Enter

Ctrl + End

Ctrl + Shift + End

Fo

Shift + F9
Ctrl + Alt + F9

Ctrl + Alt + Shift +

worksheet contains data. Press
a second time to select the
current region and its summary
rows. Press a third time to select
the entire worksheet

Select the current region around
the active cell or select an entire
PivotTable report

Select the first command on the
menu when a menu or submenu
is visible

Repeat the last command or
action, if possible

Undo the last action

Select an entire PivotTable
report

Edit the active cell and put the
insertion point at the end of its
contents. Or, if editing is turned
off for the cell, move the
insertion point into the formula
bar. If editing a formula, toggle
Point mode off or on so you can
use arrow keys to create a
reference

Expand or collapse the formula
bar

Cancel an entry in the cell or
Formula Bar

Complete an entry in the formula
bar and select the cell below

Move the cursor to the end of the
text when in the formula bar

Select all text in the formula bar
from the cursor position to the
end

Calculate all worksheets in all
open workbooks

Calculate the active worksheet

Calculate all worksheets in all
open workbooks, regardless of
whether they have changed
since the last calculation

Check dependent formulas, and

F9

Alt + Shift + F10

Ctrl + A

Ctrl + Shift + A

Ctrl + E

F4

Shift + F3
Ctrl + Shift + "

Alt + F1

F11

Alt + M then M

F3

Enter

Alt + F8

Alt + F11

F1

Page 4 of 9

then calculate all cells in all open
workbooks, including cells not
marked as needing to be
calculated

Display the menu or message for
an Error Checking button

Display the Function Arguments
dialog box when the insertion
point is to the right of a function
name in a formula

Insert argument names and
parentheses when the insertion
point is to the right of a function
name in a formula

Invoke Flash Fill to automatically
recognize patterns in adjacent
columns and fill the current
column

Cycle through all combinations
of absolute and relative
references in a formula if a cell
reference or range is selected

Insert a function

Copy the value from the cell
above the active cell into the cell
or the formula bar

Create an embedded chart of the
data in the current range

Create a chart of the data in the
current range in a separate
Chart sheet

M then D: Define a name to use
in references.

Paste a name from the Paste
Name dialog box (if names have
been defined in the workbook)

Move to the first field in the next
record of a data form

Create, run, edit, or delete a
macro

Open the Microsoft Visual Basic
For Applications Editor

Other useful shortcut keys

Displays the Excel Help task
pane



Ctrl + F1
Alt + F1

Alt + Shift + F1
F2

Shift + F2
Ctrl + F2

F3

Shift + F3

F4

F4

Ctrl + F4

Alt + F4
F5
Ctrl + F5

F6

Shift + F6

Displays or hides the ribbon

Creates an embedded chart of
the data in the current range.

Inserts a new worksheet

Edit the active cell and put the
insertion point at the end of its
contents. Or, if editing is turned
off for the cell, move the
insertion point into the formula
bar. If editing a formula, toggle
Point mode off or on so you can
use arrow keys to create a
reference

Adds or edits a cell comment

Displays the print preview area
on the Print tab in the Backstage
view

Displays the Paste Name dialog
box. Available only if names
have been defined in the
workbook

Displays the Insert
Function dialog box

Repeats the last command or
action, if possible

When a cell reference or range
is selected in a formula, F4
cycles through all the various
combinations of absolute and
relative references

Closes the selected workbook
window

Closes Excel
Displays the Go To dialog box

Restores the window size of the
selected workbook window

Switches between the
worksheet, ribbon, task pane,
and Zoom controls. In a
worksheet that has been split, F6
includes the split panes when
switching between panes and
the ribbon area

Switches between the
worksheet, Zoom controls, task
pane, and ribbon

Ctrl + F6

F7

Ctrl + F7

F8

Shift + F8

Ctrl + F8

Alt + F8

F9

Shift + F9
Ctrl + Alt + F9

Ctrl + Alt + Shift +

F9

Ctrl + F9

F10

Shift + F10

Alt + Shift + F10
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Switches to the next workbook
window when more than one
workbook window is open

Opens the Spelling dialog box to
check spelling in the active
worksheet or selected range

Performs the Move command on
the workbook window when it is
not maximized. Use the arrow
keys to move the window, and
when finished press Enter, or
Esc to cancel

Turns extend mode on or off. In
extend mode, Extended
Selection appears in the status
line, and the arrow keys extend
the selection

Enables you to add a
nonadjacent cell or range to a
selection of cells by using the
arrow keys

Performs the Size command
when a workbook is not
maximized

Displays the Macro dialog box to
create, run, edit, or delete a
macro

Calculates all worksheets in all
open workbooks

Calculates the active worksheet

Calculates all worksheets in all
open workbooks, regardless of
whether they have changed
since the last calculation

Rechecks dependent formulas,
and then calculates all cells in all
open workbooks, including cells
not marked as needing to be
calculated

Minimizes a workbook window to
an icon

Turns key tips on or off (Pressing
Alt does the same thing)

Displays the shortcut menu for a
selected item

Displays the menu or message
for an Error Checking button



Ctrl + F10

F11

Shift + F11
Alt + F11

F12

Maximizes or restores the
selected workbook window

Creates a chart of the data in the
current range in a separate
Chart sheet

Inserts a new worksheet

Opens the Microsoft Visual Basic
For Applications Editor, in which
you can create a macro by using
Visual Basic for Applications
(VBA)

Displays the Save As dialog box

CTRL combination shortcut keys

Alt

Displays the Key Tips (new
shortcuts) on the ribbon

For example, Alt, W, P switches the worksheet to

Page Layout view.

Alt, W, L switches the worksheet to Normal view.

Alt, W, | switches the worksheet to Page Break

Preview view.

Arrow keys

Ctrl + Arrow keys

Shift + Arrow keys

Ctrl + Shift +
Arrow keys

Left arrow / Right
arrow

Up arrow / Down
arrow

Move one cell to a direction you
press in a worksheet

Moves to the edge of the current
data region in a worksheet

Extends the selection of cells by
one cell

Extends the selection of cells to
the last nonblank cell in the
same column or row as the
active cell, or if the next cell is
blank, extends the selection to
the next nonblank cell

Selects the tab to the left or right
when the ribbon is selected.
When a submenu is open or
selected, these arrow keys
switch between the main menu
and the submenu. When a
ribbon tab is selected, these
keys navigate the tab buttons

Selects the previous or next
command when a menu or
submenu is open. When a

ribbon tab is selected, these
keys navigate up or down the tab

Arrow keys

Down arrow or Alt
+ Down arrow

Backspace

Backspace

Backspace

Del

Del

End

End

End

Ctrl + End

Ctrl + Shift + End
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group

In a dialog box, arrow keys move
between options in an open
drop-down list, or between
options in a group of options

Opens a selected drop-down list

Deletes one character to the left
in the Formula Bar

Also clears the content of the
active cell

In cell editing mode, it deletes
the character to the left of the
insertion point

Removes the cell contents (data
and formulas) from selected cells
without affecting cell formats or
comments

In cell editing mode, it deletes
the character to the right of the
insertion point

Turns End mode on or off. In
End mode, you can press an
arrow key to move to the next
nonblank cell in the same
column or row as the active cell.
End mode turns off automatically
after pressing the arrow key.
Make sure to press End again
before pressing the next arrow
key. End mode is shown in the
status bar when it is on

If the cells are blank, pressing
End followed by an arrow key
moves to the last cell in the row
or column

End also selects the last
command on the menu when a
menu or submenu is visible

moves to the last cell on a
worksheet, to the lowest used
row of the rightmost used
column. If the cursor is in the
formula bar, this shortcut moves
the cursor to the end of the text

Extends the selection of cells to
the last used cell on the



Enter

Enter

Enter

Enter

Alt + Enter
Ctrl + Enter

Shift + Enter

Esc

Esc

Esc

Home

Home

Home

Ctrl + Home

worksheet (lower-right corner). If
the cursor is in the formula bar,
this shortcut selects all text in the
formula bar from the cursor
position to the end—this does
not affect the height of the
formula bar

Completes a cell entry from the
cell or the Formula Bar, and
selects the cell below (by
default)

In a data form, it moves to the
first field in the next record

Opens a selected menu (press
F10 to activate the menu bar) or
performs the action for a
selected command

In a dialog box, it performs the
action for the default command
button in the dialog box (the
button with the bold outline, often
the OK button)

Starts a new line in the same cell

Fills the selected cell range with
the current entry

Completes a cell entry and
selects the cell above

Cancels an entry in the cell or
Formula Bar

Closes an open menu or
submenu, dialog box, or
message window

It also closes full screen mode
when this mode has been
applied, and returns to normal
screen mode to display the
ribbon and status bar again

Moves to the beginning of a row
in a worksheet

Moves to the cell in the upper-
left corner of the window when
Scroll Lock is turned on

Selects the first command on the
menu when a menu or submenu
is visible

Moves to the beginning of a
worksheet

Ctrl + Shift +
Home

Page Down

Alt + Page Down
Ctrl + Page Down
Ctrl + Shift + Page
Down

Page Up

Alt + Page Up

Ctrl + Page Up
Ctrl + Shift + Page
Up

Space

Ctrl + Space

Shift + Space

Ctrl + Shift +

Space

Ctrl + Shift +
Space

Ctrl + Shift +
Space

Alt + Space

Tab

Tab

Tab
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Extends the selection of cells to
the beginning of the worksheet

Moves one screen down in a
worksheet

Moves one screen to the right in
a worksheet

Moves to the next sheet in a
workbook

Selects the current and next
sheet in a workbook

Moves one screen up in a
worksheet

Moves one screen to the left in a
worksheet

Moves to the previous sheet in a
workbook

Selects the current and previous
sheet in a workbook

In a dialog box, performs the
action for the selected button, or
selects or clears a check box

Selects an entire column in a
worksheet

Selects an entire row in a
worksheet

Selects the entire worksheet

If the worksheet contains data,
this shortcut selects the current
region. Pressing Ctrl + Shift +
Spacebar a second time selects
the current region and its
summary rows. Pressing Ctrl +
Shift + Spacebar a third time
selects the entire worksheet

When an object is selected, this
shortcut selects all objects on a
worksheet

Displays the Control menu for
the Excel window

Moves one cell to the right in a
worksheet

Moves between unlocked cells in
a protected worksheet

Moves to the next option or
option group in a dialog box



Shift + Tab

Ctrl + Tab

Ctrl + Shift + Tab

Bonus tips

Ctrl + Page Up
Ctrl + Page Down
Ctrl + Shift + (
Ctrl + Shift +)
Ctrl + Shift + &
Ctrl + Shift + _
Ctrl + Shift + ~

Ctrl + Shift + $

Ctrl + Shift + %
Ctrl + Shift + A
Ctrl + Shift + #
Ctrl + Shift + @

Ctrl + Shift + !

Ctrl + Shift + *

Ctrl + Shift + :

Moves to the previous cell in a
worksheet or the previous option
in a dialog box

Switches to the next tab in dialog
box

Switches to the previous tab in a
dialog box

Switches between worksheet
tabs, from left-to-right

Switches between worksheet
tabs, from right-to-left

Unhides any hidden rows within
the selection

Unhides any hidden columns
within the selection

Applies the outline border to the
selected cells

Removes the outline border from
the selected cells

Applies the General number
format

Applies the Currency format with
two decimal places (negative
numbers in parentheses)

Applies the Percentage format
with no decimal places

Applies the Exponential number
format with two decimal places

Applies the Date format with the
day, month, and year

Applies the Time format with the
hour and minute, and AM or PM

Applies the Number format with
two decimal places, thousands
separator, and minus sign (-) for
negative values

Selects the current region
around the active cell (the data
area enclosed by blank rows and
blank columns). In a PivotTable,
it selects the entire PivotTable
report

Enters the current time

Ctrl + Shift + "

Ctrl + Shift + +

Ctrl + -

Ctrl + ;

Ctrl +°

Ctrl +'

Ctrl +1

Ctrl + 2

Ctrl + 3

Ctrl + 4
Ctrl+5
Ctrl + 6

Ctrl + 8

Ctrl +9
Ctrl+0
Ctrl + A
Ctrl + A

Ctrl + A

Ctrl + Shift + A
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Copies the value from the cell
above the active cell into the cell
or the Formula Bar

Displays the Insert dialog box to
insert blank cells

(-) Displays the Delete dialog
box to delete the selected cells

Enters the current date

Alternates between displaying
cell values and displaying
formulas in the worksheet

Copies a formula from the cell
above the active cell into the cell
or the Formula Bar

Displays the Format Cells dialog
box

Applies or removes bold
formatting

Applies or removes italic
formatting

Applies or removes underlining
Applies or removes strikethrough

Alternates between hiding
objects, displaying objects, and
displaying placeholders for
objects

Displays or hides the outline
symbols

Hides the selected rows
Hides the selected columns
Selects the entire worksheet

If the worksheet contains data,
this shortcut selects the current
region. Pressing it a second time
selects the current region and its
summary rows. Pressing it third
time selects the entire worksheet

When the insertion point is to the
right of a function name in a
formula, displays the Function
Arguments dialog box

Inserts the argument names and
parentheses when the insertion
point is to the right of a function
name in a formula



Ctrl + B

Ctrl + C

Ctrl + C then Ctrl +

C
Ctrl+ D

Ctrl + F

Shift + F5
Shift + F4
Ctrl + Shift + F

Ctrl + Gor F5

Ctrl+H

Ctrl + 1

Ctrl + K

Ctrl + N
Ctrl + O

Ctrl + Shift + O

Ctrl + P
Ctrl + Shift + P

Ctrl + R

Ctrl + S

Ctrl+T

Ctrl + U
Ctrl + Shift + U

Applies or removes bold
formatting

Copies the selected cells

Display the Clipboard

Uses the Fill Down command to
copy the contents and format of
the topmost cell of a selected
range into the cells below.

Displays the Find and Replace
dialog box, with the Find tab
selected

Also displays Find tab
Repeats the last Find action
Opens the Format Cells dialog
box with the Font tab selected

Displays the Go To dialog box

Displays the Find and Replace
dialog box, with the Replace tab
selected

Applies or removes italic
formatting

Displays the Insert Hyperlink
dialog box for new hyperlinks or
the Edit Hyperlinkdialog box for
selected existing hyperlinks

Creates a new, blank workbook

Displays the Open dialog box to
open or find a file

Selects all cells that contain
comments

Displays the Print dialog box

Opens the Format Cells dialog
box with the Font tab selected

Uses the Fill Right command to
copy the contents and format of
the leftmost cell of a selected
range into the cells to the right

Saves the active file with its
current file name, location, and
file format

Displays the Create Table dialog
box

Applies or removes underlining

Switches between expanding

Ctrl+V

Ctrl + Alt + V

Ctrl + W

Ctrl + X
Ctrl+Y

Ctri+Z

Ctrl + Shift + Z
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and collapsing of the formula bar

Inserts the contents of the
Clipboard at the insertion point
and replaces any selection.
Available only after you have cut
or copied an object, text, or cell
contents

Displays the Paste

Special dialog box. Available
only after you have cut or copied
an object, text, or cell contents
on a worksheet or in another
program

Closes the selected workbook
window

Cuts the selected cells

Repeats the last command or
action, if possible

Uses the Undo command to
reverse the last command or to
delete the last entry that you
typed

Uses

the Undo or Redo command to
reverse or restore the last
automatic correction when
AutoCorrect Smart Tags are
displayed
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